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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the 

products supplied by Meggitt SA (Meggitt Sensing Systems) are based on information believed to be 

reliable, but unless otherwise expressly agreed in writing with Meggitt SA the accuracy or 

completeness of such data is not guaranteed. Before using this product, you must evaluate it and 

determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, 

user manuals, service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability 

associated with use of the product. Meggitt SA takes no responsibility for any statements related to the 

product which are not contained in a current English language Meggitt SA (Meggitt Sensing Systems) 

publication, nor for any statements contained in extracts, summaries, translations or any other 

documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for 

new products purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight
®
 software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring systems using the versions of 

software described by this document, namely: 

 VibroSight software version 3.8.0 (CD part number 609-004-000-045). 

This document contains information about changes to the software since the previously released 

version (VibroSight 3.7.0), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight
®
 software data sheet 

        (MSS document ref. 660-020-005-218A) 

 Getting started with VibroSight
®
 installation guide 

        (MSS document ref. 660-010-006-224A) 

 VibroSight
®
 help 

 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (MSS document ref. 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in 

earlier versions of the software: 

 VibroSight 3.7.0 (MSS document ref. 660-010-013-225A) 

 VibroSight 3.6.0 (MSS document ref. 660-010-013-224A) 

 VibroSight 3.5.0 (MSS document ref. 660-010-013-223A) 

 VibroSight 3.4.0 (MSS document ref. 660-010-013-222A) 

 VibroSight 3.3.0 (MSS document ref. 660-010-013-221A) 

 VibroSight 3.2.0 (MSS document ref. 660-010-013-220A) 

 VibroSight 3.1.0 (MSS document ref. 660-010-013-219A) 

 VibroSight 3.0.0 (MSS document ref. 660-010-013-218A) 

 VibroSight 2.12.7 (MSS document ref. 660-010-013-217A) 

 VibroSight 2.12.6 (MSS document ref. 660-010-013-216A) 

 VibroSight 2.12.5 (MSS document ref. 660-010-013-215A) 

 VibroSight 2.12.4 (MSS document ref. 660-010-013-214A) 
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 VibroSight 2.12.3 (MSS document ref. 660-010-013-213A) 

 VibroSight 2.12.2 (MSS document ref. 660-010-013-212A) 

 VibroSight 2.12.1 (MSS document ref. 660-010-013-211A) 

 VibroSight 2.12.0 (MSS document ref. 660-010-013-210A) 

 VibroSight 2.11.6 (MSS document ref. 660-010-013-209A) 

 VibroSight 2.11.5 (MSS document ref. 660-010-013-208A) 

 VibroSight 2.11.4 (MSS document ref. 660-010-013-207A) 

 VibroSight 2.11.3 (MSS document ref. 660-010-013-206A) 

 VibroSight 2.11.2 (MSS document ref. 660-010-013-205A) 

 VibroSight 2.11.1 (MSS document ref. 660-010-013-204A) 

 VibroSight 2.11.0 (MSS document ref. 660-010-013-203A) 

 VibroSight 2.10.1 (MSS document ref. 660-010-013-201A) 

 VibroSight 2.10.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.0 (MSS document ref. VIBROSIGHT-RN/E). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 
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Version identifiers 

A complete VibroSight software version number has four components that provide the following 

information: 

 Major release identifier: x.x.x.x 

 Minor release identifier: x.x.x.x 

 Update release identifier: x.x.x.x 

 Maintenance (build) release identifier: x.x.x.x 

For each scheduled release of VibroSight, at least one of the first three digits changes (x.x.x.x). 

For unscheduled releases, that are occasionally required to solve urgent problems, only the fourth 

digit changes (x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight
®
 software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the new CPUR/IOCR card pair. 

Where CPUx card is used in this document, it refers to CPUM and CPUR cards, and where 

IOCx card is used in this document, it refers to IOCN and IOCR cards, unless otherwise stated. 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 

 VibroSmart
®
 module or VibroSmart

®
 device – to refer to VibroSight-software compatible 

modules or devices that are used in a distributed monitoring system. The currently available 

VibroSmart modules and devices that are designed for operation with the VibroSight software 

are the VSI010, VSN010 and VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x 

modules, unless otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to 

the VSI010 and VSV30x modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

In general, the licence required to enable purchased product options remains unchanged between 

update and/or maintenance level releases, for example, from version 3.7.0 to version 3.8.0. 

However, a new licence is always required for upgrades between major level releases, for example, 

from version 2.x.x to version 3.x.x. 

NOTE: VibroSight 3.8.0 is a minor level release and a new licence key file is not required 

for upgrades from VibroSight 3.7.0. 

However, a new licence key file is required for upgrades from VibroSight 2.x.x. 

 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See 7 Customer support. 

 

 

2 Features 

General 

2.1 Filtered orbits for VibroSmart VSV30x modules 

The VibroSight software now includes support for filtered orbits from VibroSmart VSV30x modules. 

(Previously, the VibroSight software supported unfiltered orbits only from VibroSmart VSV30x 

modules, and both unfiltered and filtered orbits from VM600 XMx16 cards.) 

 

NOTE: Compared to unfiltered Orbits which are “overall” orbits obtained directly from 

channel/processing block waveforms, Filtered orbits are obtained from 

channel/processing block vectors (frequency-domain extractions) and allow more 

detailed diagnosis of machinery problems that require frequency-filtered amplitude 

and phase information, related to multiples of the machine running speed such as 

0.5X, 1X, 2X and so on. 

 

To use filtered orbits with VibroSmart VSV30x monitoring modules: 

 VibroSight Configurator is used to configure filtered orbit measurements, which require two 

dynamic measurement channels, two shaft relative vibration processing blocks and one dual 

shaft relative processing block, configured for the measurement chains being used such as 

TQ4xx, EA40x and IQS450 proximity measurement chains, from the Meggitt Vibro-Meter
®
 

product line. 

 VibroSight Vision is used to display the resultant filtered orbit measurements using the Orbit plot 

type. 
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To configure and use filtered orbits with VibroSmart VSV30x modules: 

 

To configure filtered orbits for VibroSmart VSV30x monitoring modules using VibroSight Configurator: 

 Start VibroSight Configurator, log in at the Admin user level and create a new VibroSight Server 

configuration (File > New > VibroSight Server configuration). 

Alternatively, open and modify an existing configuration (File > Open > … (*.vscfg)). 

 In the Hardware view, at the VibroSight Server Configuration node level, add a VibroSmart 

measurement block and a VSV30x module. 

 For the VSV30x module, at the Input channels level, add and configure an Auxiliary input 

channel as a Tacho input channel in order to generate the 1/rev pulse required for filtered 

orbits, as usual. 

NOTE: A tacho (1/rev pulse) must be configured and available in order for filtered orbits to 

be generated. 

 

 For the VSV30x module, at the Input channels level, add and configure two Dynamic channels 

to interface with the proximity measurement chains being used and measure the orthogonal x 

and y displacements, as usual. 

 For the VSV30x module, at the Processing blocks level, add and configure the two Shaft relative 

vibration processing blocks required by a VSV30x to generate orbits and filtered orbits. 

Note: Shaft relative vibration processing blocks provide the x and y waveforms required for 

orbits. 

 For the VSV30x module, at each of the two Shaft relative vibration processing block levels, add 

a Secondary path frequency domain extraction, then at the Frequency domain extraction level, 

add a Vector data entity. 

Note: Shaft relative vibration processing blocks with frequency domain extractions with vector 

data entities provide the x and y vectors (amplitude and phase) required for filtered orbits. 

NOTE: In order to provide the data (vectors) required for filtered orbits: 

The Shaft relative vibration processing block frequency domain extractions must be 

configured with Extraction type: Harmonics and Harmonic type: n, where n is the 

multiple of the machine speed (nX). 

 

 For the VSV30x module, at the Processing blocks level, add and configure a Dual shaft relative 

processing block required by a VSV30x to generate orbits and filtered orbits. 

 For the VSV30x module, at the Dual shaft relative processing block level, add a Filtered Orbit 

data entity, then configure the Filtered Orbit to use the vectors configured at each of the two 

Shaft relative vibration processing block levels. 

NOTE: The filtered orbits must be configured with X vector: Name of the x vector data 

entity and Y vector: Name of the y vector data entity. 
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The VibroSmart VSV30x configuration with a filtered orbit is now complete but must be saved as a 

‘server / database’ and applied (activated) as usual before it can be used. 

After the configuration is applied (activated) and running on the VibroSight Server, ensure that 

VibroSmart device driver, and any other required device drivers and server features, are enabled on 

the VibroSight Server Status tab, under Device drivers. 

 

VibroSight Vision is used to display filtered orbits in the same way as orbits and all other 

measurements (data): 

 Using the Machinery view or Hardware view to select the machinery and measurement(s) to 

display. 

 Using the Time Range to select historical or live data (and the time period of interest for 

historical data). 

Similarly, VibroSight Configurator can be used to configure data logging for filtered orbits and so on. 

 

 

2.2 Import of Boolean values by a VibroSight OPC client 

A VibroSight OPC client (master) can now import Boolean data into a VibroSight Server data 

repository from external systems. 

NOTE: Once imported into a VibroSight Server data repository (VibroSight historical data 

folder (*.vshdf)), Boolean data is treated in the same way as any other data in 

the data repository, and can be logged, displayed, analysed, exported and so on. 

 

To import and use Boolean data with VibroSmart: 

 VibroSight Configurator is used to configure a VibroSight OPC client to import the Boolean data. 

 VibroSight Vision is used to display and analyse the Boolean data. 

 

 

To import and use Boolean data from external systems: 

 

To configure a VibroSight Server to import Boolean data using VibroSight Configurator: 

 Start VibroSight Configurator, log in at the Admin user level and create a new VibroSight Server 

configuration (File > New > VibroSight Server configuration). 

Alternatively, open and modify an existing configuration (File > Open > … (*.vscfg)). 

 In the Hardware view, at the VibroSight Server Configuration node level, add an OPC device. 
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 For the OPC device, configure the Name, Host and OPC server in the main working window 

(centre). 

The default Name and Host settings can be used but for the OPC server, the 

OPC Server Name must be configured to use the external OPC server from which data is 

being imported. 

 In the Hardware view, at the OPC device node level, add a Processing block. 

 For the Processing block, configure the Name, Update rate and Read mode in the main 

working window (centre). 

 In the Hardware view, at the Processing block node level, add a Data entity. 

 For the Data entity, configure the Name, OPC tag, Unit, Scale factor, Physical Quantity, 

Qualifier, Offset, Full display range and Alarms in the main working window (centre), as 

usual. 

When configuring the OPC tag using the Browse button, use the Choose an OPC tag 

window to select the data to import. 

NOTE: The Choose an OPC tag window now displays Boolean data types (VT_BOOL) 

with a green icon meaning that can be selected for import to a VibroSight OPC 

client. 

(Previously, Boolean data types were displayed with a red icon meaning that it was 

not possible to select them for import.). 

 

The VibroSight Server configuration importing Boolean data is now complete but must be saved as a 

‘server / database’ and applied (activated) as usual before it can be used. 

After the configuration is applied (activated) and running on the VibroSight Server, ensure that the 

OPC device driver, and any other required device drivers and server features, are enabled on the 

VibroSight Server Status tab, under Device drivers. 

 

 

VibroSight Vision is used to display imported Boolean data in the same way as all data 

(measurements): 

 Using the Machinery view or Hardware view to select the OPC device (machinery) and Boolean 

data (measurement) to display. 

 Using the Time Range to select historical or live data (and the time period of interest for 

historical data). 

NOTE: In VibroSight, Boolean data is (VT_BOOL) is imported and treated as a floating 

point data with a value of either 0 (false) or true (1). 

 

Similarly, VibroSight Configurator can be used to configure data logging for imported Boolean data, 

data export and so on. 
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VibroSmart modules 

2.3 VSI010 module: fieldbus communication of alarm limits 

The VibroSight software has been improved to support the communication of more user-configurable 

alarm information via the fieldbus ports (Modbus or PROFIBUS) of a VSI010 communications interface 

module. 

More specifically, in a VibroSmart measurement block containing a VSI010 module, the individual 

alarm severity level limit values configured for the various alarms for the different modules in the 

measurement block can now be added to the configuration of the VSI010 module’s fieldbus port(s) as 

data values. In this way, the alarm limit information for a VibroSmart system is more easily available 

for ease of development of third-party systems such as a DCS or PLC. 

The alarm severity level limit values that can now be shared via fieldbus are: 

 Danger+ 

 Alert+ 

 Alert− 

 Danger− 

(Previously, the information available via fieldbus for an alarm was bit-based only, such as overall 

alarm validity (alarm validity flag) and individual alarm statuses (Danger+, Alert+, Alert− and 

Danger−).) 

 

Alarm severity level limit values are added to a VSI010 module at the individual fieldbus port node 

level (Modbus port n or Profibus port n), by clicking on Add and using the Add data window to add 

the required alarm severity level limit values (Alarms limits) to the fieldbus port. 

 

 

2.4 VSI010 module: constants 

The VibroSmart VSI010 communications interface module firmware has been improved to support 

more user-configurable constants, which can be added to a VSI010 module’s configuration and 

communicated via its fieldbus ports (Modbus or PROFIBUS). 

There is now no limit on the number of constants per VSI010 module. (Previously, there was an upper 

limit of 20 constants per VSI010 module.) 

The constants that can be configured are Boolean (bit, 1 bit), Integer (unsigned short integer, 2 bytes) 

and Float (single, 4 bytes). 

NOTE: Constants can be used in a VibroSight system to help debug and test a fieldbus 

port during the development of a system and/or to provide additional data from a 

system, for example, configuration version information. 
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Constants are added to a VSI010 module at the constants node level (Constants), by right-clicking 

Constants, adding the type of constant and assigning a value. 

NOTE: In order to run VibroSight 3.8.0 for machinery monitoring systems containing 

VibroSmart VSVI010 modules, a firmware upgrade to the latest version of VSVI010 

firmware is recommended but is not required. See 5.3 VibroSmart devices. 
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 3.8.0 software. 

 

3.2 Problems filtering selected data entities when working with data logging in 
VibroSight Configurator 

When configuring and working with data logging in VibroSight Configurator, when the Data entities 

node level was selected in the Data storage view, the Filtering in the toolbar of the main working 

window (centre) did not display the filter on Selected data entities option. 

 

3.3 Problems with the persistence of initial settings for a VibroSight Server 

When a VibroSight Server is initially created (File > Save as > Server / database in VibroSight 

Configurator) and the configuration is applied/activated (File > Apply changes to 

running configuration in VibroSight Configurator), all of the Device drivers and Server features 

settings for the VibroSight Server are initially configured as enabled. 

However, any changes (disabled/enabled) to the Device drivers and Server features settings by the 

user were not persisted (“remembered”) by the VibroSight Server the first time that it was 

closed/exited (File > Quit) and then restarted. That is, the VibroSight Server would again default to all 

settings initially enabled. Although, subsequent restarts did correctly persist (“remember”) the user-

configured settings. 

 

3.4 Problems running a VibroSight Server as a Windows service 

When a VibroSight Server was registered as a Windows service (VibroSight Server actions, Register 

command in VibroSight System Manager) and the service tried to start, it could not be started 

automatically by Windows. Neither could not be started manually using VibroSight System Manager. 

And a message such as “Service 'VibroSight Server - aux_test' could not be started. The service did 

not respond to the start or control request in a timely fashion" was reported. 

 

3.5 Problems configuring Secondary path frequency domain extractions for 
VibroSmart VSV30x modules in VibroSight Configurator 

When configuring and working with data extractions for VibroSmart VSV30x modules in VibroSight 

Configurator and more specifically, using copy (CTRL+C) and paste (CTR+V) to duplicate an existing 

(that is, already configured) Secondary path frequency domain extraction for an Asynchronous 

absolute bearing vibration processing block, VibroSight Configurator did not paste (duplicate) the 

copied Secondary path frequency domain extraction and reported a message such as “An unexpected 

error occurred. (Unexpected error – NullReferenceException)”. 
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3.6 Problems configuring Dual shaft relative processing for VM600 XMx16 
cards in VibroSight Configurator 

When configuring and working with dual-channel processing for VM600 XMx16 cards in VibroSight 

Configurator and more specifically, using copy (CTRL+C) and paste (CTR+V) to duplicate an existing 

(that is, already configured) Dual shaft relative processing block containing Orbit, Shaft centreline and 

Smax data entities, VibroSight Configurator did not paste (duplicate) the copied Dual shaft relative 

processing block and reported a message such as “An unexpected error occurred. (Unexpected error 

– NullReferenceException)”. 

 

3.7 Problems with communications between VibroSight Vision and a 
VibroSight Server for the display of live data 

Under certain circumstances, when the communications between VibroSight Vision and a VibroSight 

Server were repeatedly interrupted during normal operation, for example, due to underlying network 

infrastructure problems (for example, network hardware failures and/or cabling faults, and/or power 

outages), the VibroSight Server could enter a “state” in which it would not provide live data to 

VibroSight Vision and a VibroSight Server restart was required. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time 

or Local computer time and the site time or local computer time is subsequently changed on the 

relevant computer (for example, using Windows > Control Panel > Date and Time), this change is not 

reflected in the VibroSight Vision user interface until the user clicks on the Timestamp displayed in 

the VibroSight Vision status bar. 

 

4.2 VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 

hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 

VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the file names used for a VibroSight Server 

database file (*.vssrvdb or *.db) and a VibroSight Server configuration file (*.vssrvcfg or 

*.config) should be updated (and manually edited in the VibroSight configuration file) to be 

18 characters or less. Changes may also be required in any VibroSight software that references the 

server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 

(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that 

remain available for VibroSight Server instance names to three. Alternatively, the server instance 

name can be shorted after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any 

truncation performed by VibroSight, it is possible that servers are created with names that contain 

non-allowed characters (such as spaces), with the result that these servers will not be accessible by 

VibroSight software clients. Similarly, duplicate VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 

arising due to truncation and/or additional data repositories being created during 

automatic data management. 

This is particularly important for systems with automated data management and 

system backup procedures that can generate VibroSight Server data repositories 

with different file names. 

 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, 

UTC time or Local computer time, all other VibroSight client software modules continue to display 

timestamps in local computer time only (that is, the date and time according to the local clock of the 

computer running the VibroSight software module). 

 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always 

update correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the 

network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a 

refresh (using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight 

Mimic client software module for mimics (that were previously available in VibroSight Vision). As a 

result, VibroSight Vision mimics created with VibroSight 2.9.7 or earlier are not compatible with 

VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client 

software module. As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are 

not compatible with VibroSight 2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to 

include version information, in order to improve the compatibility between projects created with 

different versions of VibroSight Mimic and eliminate the requirement for the recreation of Mimics. 

Starting with VibroSight 2.11.5, Mimic projects automatically detect any changes in the VibroSight 

Mimic software that affect project compatibility, inform the user and update the project as required. 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 

VibroSight 2.11.0 or later, if the corresponding database had been updated as 

required. 
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NOTE: When updating existing machinery monitoring projects created with 

VibroSight 2.12.x to VibroSight 3.x.x, a new data repository created by copying a 

VibroSight database (*.vssrvdb) to a VibroSight historical data folder (*.vshdf) 

must use the same server file name as the existing server in order for existing 

VibroSight Mimics to maintain links with the data repository and continue to work 

(without manual corrections). 

In addition, the VibroSight Server using the new data repository must be running 

before the existing VibroSight Mimics are run for the first time, after the update. 

 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a 

VibroSight system and the external OPC server becomes unavailable, the VibroSight OPC Client may 

not always recover automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error 

messages even when OPC server is available and can result in permanent loss of the imported data if 

not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 

as expected. 

Any VibroSight system feature or configuration element relying on the imported 

OPC data will not behave as expected, for example, alarms, machinery operating 

conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

 Stop and restart the VibroSight OPC Client from either the VibroSight Server 

(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

 Stop and restart the VibroSight Server, if required. 

 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event 

information available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event 

information available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate 

events being listed in the Event Viewer, particularly for VibroSight systems being operated without an 

NTP server (where events are not recognised as duplicates due to time drift). 
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4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server 

are not correctly displayed and updated when an NVIDIA WMI driver is installed on the same 

computer as the VibroSight Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 

management and control technology that interfaces to Microsoft’s Windows 

Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 

processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required 

counter values from the underlying operating system / computer. 

 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing 

Block that is used as an input to a Dual Shaft Relative Processing Block which is configured to provide 

an Orbit and/or Full Spectrum output, then any pre-logging configured for the principal mode 

Waveform and/or Spectrum of Dynamic Input Channel 16 will not actually log any of the data from the 

same pre-logging scope. 

 

4.11 Problems creating new VibroSight OPC Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 

VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight 

OPC Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System 

Manager displaying an error message such as 

“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ 

threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight 

OPC Servers is being used by the later installation of VibroSight, which can happen in one of two 

ways: 

 When a later version of VibroSight 3.x.x is installed on a computer that was running an earlier 

version of VibroSight 2.x.x, the VibroSight installer automatically checks existing VibroSight folders 

(such as C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user 

preference files across to the new VibroSight folders (such as 

C:\ProgramData\Meggitt\VibroSight), including an earlier OpcServer.config file. 

 When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of 

a VibroSight OPC installer using VibroSight 3.0.0 automatically created an earlier 

OpcServer.config file. 
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As shown below, the first few lines of a typical OpcServer.config file contains version specific 

information that is incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems 

are experienced when creating new VibroSight OPC Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the 

version specific information. That is, change the line containing the section name 

from: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 

    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 

    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Servers to VibroSight 3.x.x is 

described in detail in the “VibroSight OPC Server migration” section of the latest 

 Getting started with VibroSight installation guide. 
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4.12 Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with 

the VibroSight software. So if the computer running the VibroSight software is running other software 

which also requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight 

(or the other software) from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically 

detect other software on the computer that is using TCP port 50000 and report this. For example: “The 

port 50000 cannot be used. Please close all application using this port before manually starting the 

host service.” 

Accordingly, any potential TCP port 5000 conflict should be resolved before the VibroSight software 

can be successfully installed and run. 

 

4.13 Problems using shared network drives/locations for VibroSight 
data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using 

shared network drives/locations with VibroSight’s integrated data management operations such as 

Offline data storage and Database backup (configured in VibroSight Configurator) due to Windows 

security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a 

VibroSight Server (corresponding to Offline data storage and Database backup operations) failing to 

run correctly. More specifically, on the Data Management tab of a VibroSight Server, scheduled 

incremental copy jobs (Type: Copy) are typically displayed with Status: Error, while the Log Messages 

tab of the server display typically displays messages such as “Errors during the copy 

operation” and “Uncaught error IOException occurred in task ‘Task 

“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 

with a change to the rules governing shared network drives/locations. 

More specifically, a shared network drive/location is now only accessible and 

visible to the user who created the shared network drive/location, even if the user is 

an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 

Windows Server 2016 computers that is required to be used by VibroSight’s integrated data 

management operations should be created as a “system account” in order to ensure that the required 

Windows Services can access the shared resource (drive/location). 

This can easily be done using Microsoft’s PsExec utility. For example, by running the following 

command (as an Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to 

the devicename (Z:). 

 

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
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NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 

with a change to the rules governing shared network drives/locations. 

More specifically, a shared network drive/location is now only accessible and 

visible to the user who created the shared network drive/location, even if the user is 

an Administrator. 

 

4.14 Problems installing VibroSight 3.7.x on computers without 
internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience 

problems when automatically installing the prerequisite Microsoft Visual C++ Redistributable Package 

for Visual Studio 2015, and report a generic message such as “Setup Failed. One or more issues 

caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual 

Studio 2015, the Microsoft Visual C++ installer can also experience problems, and report a similar 

generic “Setup Failed” message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by 

a certification authority that is not installed on the computer, and the computer cannot automatically 

download the required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 

http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  

Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the 

command line. 

Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 

certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 

 

If required, additional information is available from a Microsoft MSDN blog, here: 

https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-

trusted-root-authority-2 

 

 

  

https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check 

to see if the required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package and 

OPC Core Components Redistributable software are pre-installed on the computer: 

 The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually 

installed before VibroSight can be installed. If it is not detected, then the VibroSight installer will 

exit the installation and VibroSight is not installed. 

 The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the 

VibroSight installer if it is not detected. 

 The required OPC Core Components Redistributable (see section 5.1.4) software is automatically 

installed on the computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 

VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 3.8.0 is a minor level release and replaces VibroSight 3.7.0. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data 

migration process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data 

repositories based on the VibroSight historical data repositories (VibroSight historical data folder 

(*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archive 

(*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers 

that were created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC 

Server migration process for these VibroSight OPC Servers. 

Therefore, it is important to note that: 

 New machinery monitoring projects created with VibroSight 3.x.x will automatically use VibroSight 

historical data repositories. 

 Existing machinery monitoring projects created with versions of VibroSight earlier than 

VibroSight 3.0.0 must be manually migrated from Sybase SQL Anywhere databases to VibroSight 

historical data repositories before they can be used with VibroSight 3.x.x. 

 Existing machinery monitoring projects using VibroSight OPC Servers that were created with 

versions of VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC 

Servers before they can be used with VibroSight 3.x.x. 

It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or 

earlier to VibroSight 3.x.x requires that certain steps must be performed using the existing version 

of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 
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NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” and “VibroSight OPC 

Server migration” sections of the latest  Getting started with VibroSight 

installation guide. 

 

5.1.1 Microsoft Windows operating systems 

VibroSight 3.x.x is compatible with 32-bit versions and 64-bit versions of Microsoft 
®
 Windows 

®
 

operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 

software for 64-bit Windows and 32-bit software for 32-bit Windows. 

The 64-bit version of VibroSight can be installed on 64-bit Windows computers 

only. The 32-bit version of VibroSight can be installed on 32-bit Windows 

computers only. Only a single version of VibroSight can be installed and exist on a 

computer at any one time 

 

See the Appendix of these release notes for further information on VibroSight software and Windows 

operating system compatibility. 

 

5.1.2 Microsoft .NET Framework 

For most Windows operating systems, VibroSight 3.7.0 or later requires that the Microsoft .NET 

Framework 4.7.2 or later is installed. 

NOTE: VibroSight 3.8.0 requires Microsoft .NET Framework 4.7.2. 

 

If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect 

this and automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft 

.NET Framework requirements. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 

VibroSight 3.x.x requires that the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 

is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 

computers. 

 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight 

installer will detect this and exit the installation. 
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5.1.4 OPC Core Components Redistributable 

VibroSight 3.x.x requires that the OPC Core Components Redistributable is installed, in order to 

configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable 

must be installed on OPC client computers in order to allow connections to remote OPC servers and it 

must be installed on OPC server computers in order to allow OPC clients to browse for running OPC 

servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 

computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer 

will detect this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 Sybase SQL Anywhere 11 software 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data 

folder (*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data 

archive (*.vshda) for operation with historical data) are exclusively used for the required data 

repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a 

data repository. Accordingly, the Sybase SQL Anywhere 11 database software is no longer included 

and distributed as part of the VibroSight software. 

NOTE: VibroSight 3.x.x exclusively uses data repositories based on the VibroSight 

historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 

databases and introduced initial support for working with data repositories based 

on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 

SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” section of the latest 

 Getting started with VibroSight installation guide. 
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5.1.6 VM600 CMS software 

The VM600 CMS software from Meggitt Sensing Systems uses Sybase SQL Anywhere 8. Both 

Sybase SQL Anywhere 8 (VM600 CMS) and Sybase SQL Anywhere 11 (VibroSight) can be installed 

on the same computer. 

However, while SQL Anywhere 8 and SQL Anywhere 11 can be installed on the same computer and 

run at the same time for standard database operations, certain administrative tasks are mutually 

exclusive and may block one another. 

More specifically, all operations that refer to Sybase SQL (a command-line Interactive SQL utility) in 

the background could be directed to the wrong version of Sybase SQL Anywhere. For example, this 

impacts all user operations and system operations involving the creation, copying and updating of 

databases. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have VM600 CMS software installed. 

 

5.1.7 SIMATIC Step 7 software 

The SIMATIC Step 7 software from Siemens typically uses Sybase SQL Anywhere 9. Both Sybase 

SQL Anywhere 9 (SIMATIC Step 7) and Sybase SQL Anywhere 11 (VibroSight) can be installed on 

the same computer. 

However, while SQL Anywhere 9 and SQL Anywhere 11 can be installed on the same computer, they 

cannot run at the same time. 

More specifically, if SIMATIC Step 7 and VibroSight are both installed, certain administrative tasks, 

such as all user operations and system operations involving the creation, copying and updating of data 

repositories (databases), may not work correctly. If this behaviour is seen, the recommended 

workaround is to manually change or remove the SQLANY environmental variable in order to allow 

VibroSight to work correctly. 

Note: The SQLANY environment variable is used to contain the directory where Sybase SQL 

Anywhere is installed. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have SIMATIC Step 7 software installed. 

 

5.1.8 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience 

problems running the VibroSight software, characterised by the VibroSight software not running or 

running incorrectly. This is because the Dell Backup and Recovery software can use a version of 

SQLite and associated libraries (DLLs) that prevent the VibroSight Host Service from running 

correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect 

to data sources and/or VibroSight System manager may not display all of the commands expected to 

be available in the Actions window. 
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If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery 

software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have Dell Backup and Recovery software installed. 

 

5.1.9 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same 

computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in 

problems related to credentials (access rights). These problems are typically characterised by an 

unhandled exception in VibroSight Configurator when trying to configure an OPC device in the 

Hardware view or an unhandled exception in a VibroSight Server when trying to handle/process OPC 

data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the 

following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 

Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 

or later). Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x. 
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5.2 VM600 cards 

5.2.1 Firmware 

There are no firmware upgrades for VM600 cards corresponding to VibroSight 3.8.0. 

The latest firmware for the CPUR remains: 

 Base System: base-system-640-014-001-002.tgz 

 Applications:  applications-640-015-001-002.tgz. 

The latest firmware for the XMC16, XMV16 and XMVS16 remains: 

 Base System: base-system-640-003-001-016.tgz 

 Applications:  applications-640-010-001-016.tgz. 

Therefore, for current versions of VM600 cards, firmware upgrades are not required. 

 

5.3 VibroSmart devices 

5.3.1 Firmware 

There are firmware upgrades for some VibroSmart modules and devices corresponding to 

VibroSight 3.8.0. 

The latest firmware for the VSI010 module is now: 

 642-002-000-010.xmsifw. 

Therefore, for current versions of VibroSmart VSI010 modules, firmware upgrades are recommended 

but are not required (see 2.4 VSI010 module: constants). 

 

The latest firmware for the VSN010 device remains: 

 642-004-000-011.redboxfw. 

The latest firmware for the VSV30x module remains: 

 642-001-000-016.xtranfw. 

Therefore, for current versions of VibroSmart VSN010 devices and VSV30x modules, firmware 

upgrades are not required. 

 

6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards and VibroSmart modules and devices) before starting a 

VibroSight system upgrade, in order to establish if any firmware updates are also 

required. 

See 6.2.3 Updating the firmware using VibroSight System Manager. 
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NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. See 6.2.3 Updating the 

firmware using VibroSight System Manager. 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer 

running VibroSight to keep track of user-configurable settings, so that these settings are remembered 

and applied for the VibroSight installation. 

These settings files have an .xmssettings file name extension and on a computer running 

Windows 7, can be found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows 

account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default 

settings for VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 

• For a computer on which VibroSight was previously installed, an update, upgrade 

or a re-installation of VibroSight will continue to use the previous defaults recorded 

in the .xmssettings files. 

• For a computer on which VibroSight was not previously installed, the installation 

of VibroSight will generate and use new .xmssettings files, which use the latest 

VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 

settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and 

VibroSmart devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to 

take advantage of improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used 

unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 

acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal 

machinery monitoring functions because its outputs (alarms and relays) can go to undetermined 

states, irrespective of how they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware 

update and the restart (reboot) that is triggered automatically after the firmware update (which can 

take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that 

is, CPUR firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 

firmware and VM600 XMx16 firmware that is compatible with the version of 

VibroSight software being used. 
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Table 1: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware. See note 1 

VibroSight software 

version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 640-014-001-002 

Applications (*.tgz) 

640-015-001-001 640-015-001-002 

2.12.7 

609-004-000-036 
 

See note 2
  

See note 3
 

3.0.0 

609-004-000-037 
  

3.1.0 

609-004-000-038 
  

3.2.0 

609-004-000-039 
  

3.3.0 

609-004-000-040 
  

3.4.0 

609-004-000-041 
  

3.5.0 

609-004-000-042 
  

3.6.0 

609-004-000-043 
  

3.7.0 

609-004-000-044 
  

3.8.0 

609-004-000-045 
  

 

Notes for Table 1 (see the next page)  
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Notes for Table 1 

1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-

014-001-xxx for the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx 

denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-014-000-xxx for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This is the first official release of VM600 CPUR firmware and includes features such as the management of XMx16 card 

configurations for applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus 

interfaces. A firmware upgrade is required in order to run VibroSight 2.12.7 or later. 

 

3. This version of VM600 CPUR firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus 

server to 100 ms (was 200 ms) and fixing a known time counter wraparound (overflow) issue. A firmware upgrade is strongly 

recommended in order to run VibroSight 3.4.0 or later. 
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Table 2: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware. See note 1 

VibroSight 

software 

version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-011 

640-003- 

001-012 

640-003- 

001-013 

640-003- 

001-014 

640-003- 

001-016 

Applications (*.tgz) 

640-010- 

001-011 

640-010- 

001-012 

640-010- 

001-013 

640-010- 

001-014 

640-010- 

001-016 

2.12.5 

609-004-000-033 
 

See note 2
  

See note 3
 

   

2.12.6 

609-004-000-034 
  

   

2.12.7 

609-004-000-036 
   

See note 4
  

 

3.0.0 

609-004-000-037 
    

See note 5
  

3.1.0 

609-004-000-038 
     

3.2.0 

609-004-000-039 
     

3.3.0 

609-004-000-040 
     

See note 6
 

3.4.0 

609-004-000-041 
     

3.5.0 

609-004-000-042 
     

3.6.0 

609-004-000-043 
     

3.7.0 

609-004-000-044 
     

3.8.0 

609-004-000-045 
     

 

Notes for Table 2 (see the next page)  
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Notes for Table 2 

1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-

003-001-xxx for the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx 

denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-010-000-xxx for the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 firmware introduces support for 1 s time-boxed peak-hold processing (that is, spectral data 

aggregation). 

 

3. This version of VM600 XMx16 firmware implements improved multi-rate digital resamplers (sample rate converters). 

A firmware upgrade is recommended but is not required in order to run VibroSight 2.12.5 or 2.12.6. 

 

4. This version of VM600 XMx16 firmware improves support for faster live data: 100 ms card update rate and up to 100 ms 

VibroSight Vision refresh rate. It also allows a VM600 XMx16 card to be managed by a VM600 CPUR card (“rack controller”), 

eliminating the XMx16 card’s requirement for a VibroSight Server. A firmware upgrade is required in order to run 

VibroSight 2.12.7. 

 

5. This version of VM600 XMx16 firmware adds support for customer-specific functionality that is enabled by a customer-specific 

VibroSight software licence. A firmware upgrade is required in order to run VibroSight 3.0.0 or later. 

 

6. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised 

memory to reduce the possibility of missing data in data intensive VibroSight applications running on less powerful computers. A 

firmware upgrade is required in order to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by 

their .*fw file name extension. For example, the VSV30x subfolder contains the firmware for use by 

VSV30x modules. Any additional firmware updates received from Meggitt Sensing Systems should 

also be stored in these directories. 

Table 3 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 4 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 

firmware that is compatible with the version of VibroSight software being used. 
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Table 3: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw). See note 1 

VibroSight 

software version 

CD part number 

642-002- 

000-008 

642-002- 

000-009 

642-002- 

000-010 

2.12.3 

609-004-000-030 


 See note 2
 

  

2.12.4 

609-004-000-032 
 

  

2.12.5 

609-004-000-033 
 

  

2.12.6 

609-004-000-034 
 

 See note 2
 


See notes 

2 and 3
 

2.12.7 

609-004-000-036 
   

3.0.0 

609-004-000-037 
   

3.1.0 

609-004-000-038 
   

3.2.0 

609-004-000-039 
   

3.3.0 

609-004-000-040 
   

3.4.0 

609-004-000-041 
   

3.5.0 

609-004-000-042 
   

3.6.0 

609-004-000-043 
   

3.7.0 

609-004-000-044 
   

3.8.0 

609-004-000-045 
   

 

Notes for Table 3 (see the next page)  
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Notes for Table 3 

1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-

xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 

 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 

A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 
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Table 4: VibroSight software and VibroSmart VSN010 firmware compatibility 

 
VSN010 firmware 

(*.redboxfw). See note 1 

VibroSight 

software 

version 

CD part number 

642-004- 

000-010 

642-004- 

000-011 

2.12.3 

609-004-000-030 


 See note 2
 

 

2.12.4 

609-004-000-032 
 

 

2.12.5 

609-004-000-033 
 

 

2.12.6 

609-004-000-034 
 

 See note 2
 

2.12.7 

609-004-000-036 
  

3.0.0 

609-004-000-037 
  

3.1.0 

609-004-000-038 
  

3.2.0 

609-004-000-039 
  

3.3.0 

609-004-000-040 
  

3.4.0 

609-004-000-041 
  

3.5.0 

609-004-000-042 
  

3.6.0 

609-004-000-043 
  

3.7.0 

609-004-000-044 
  

3.8.0 

609-004-000-045 
  

 

Notes for Table 4 (see the next page)  
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Notes for Table 4 

1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-

000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 5: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw). See note 1 

VibroSight 

software version 

CD part number 

642-001-000-

012 

642-001-000-

013 

642-001-000-

014 

642-001-000-

015 

642-001-000-

016 

2.12.3 

609-004-000-030 


 See note 2
 

    

2.12.4 

609-004-000-032 
 

    

2.12.5 

609-004-000-033 
 

 See note 2
 

   

2.12.6 

609-004-000-034 
  

 See note 2
 

  

2.12.7 

609-004-000-036 
   

  

3.0.0 

609-004-000-037 
   

  

3.1.0 

609-004-000-038 
   

  

3.2.0 

609-004-000-039 
   

  

3.3.0 

609-004-000-040 
   

  

3.4.0 

609-004-000-041 
   


See notes 

2 and 3
 


See notes 

2 and 4
 

3.5.0 

609-004-000-042 
     

3.6.0 

609-004-000-043 
     

3.7.0 

609-004-000-044 
     

3.8.0 

609-004-000-045 
     

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 

1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-

000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 

 

3. This version of VibroSmart VSV30x firmware introduces support for hydro air-gap monitoring. 

A firmware upgrade is required in order to run VibroSight 3.4.0 or later. 

 

4. This version of VibroSmart VSV30x firmware introduces support for latched alarms. 

A firmware upgrade is recommended but is not required in order to run VibroSight 3.6.0 or later. 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards and VibroSmart devices already 

corresponds to the latest available version that no firmware update is required. Therefore, it is strongly 

recommended to verify the version of firmware running on the hardware before starting a VibroSight 

system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. 

Alternatively, multiple modules of the same type (for example, VSV3x0) can be updated to the same 

version of firmware at the same time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 

updates to the VibroSight software corresponding to updates to VibroSmart 

modules), VibroSight Configurator should be used to obtain a copy of the 

configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 

command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 

VibroSmart), the File > Open > Device command can be used to read the 

configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 

configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards or VibroSmart devices in the tree structure or some cards 

are missing, verify your network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use 

CTRL+click or SHIFT+click to select multiple devices from the Devices tree-view. (Then, when 

the Change Firmware command is run, all of the devices that were selected will be updated at 

the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card or VibroSmart device 

selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 

5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks or VibroSmart distributed monitoring systems, where systems are 

operating with different versions of VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been 

inadvertently modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data 

acquisition and external interfaces, data post-processing and/or logging are all configured as 

expected. 

 

In a VibroSight Server user interface: 

 On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus 

controls are enabled or disabled as required by your application. 

 On the Status tab under Server features, check that the Basic math, Air gap, Combustion 

monitoring, Duration counters, VSHDA import and Data logging manager controls are enabled or 

disabled as required by your application. 

 On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 

(VM600 cards and /or VibroSmart modules) have been discovered and that data acquisition has 

resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 

Server user interface is not displayed, so VibroSight System Manager must be 

used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 

in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any 

VibroSight Servers in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Meggitt SA 

Customer support department 

Route de Moncor 4 

PO Box 1616 

1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3 Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows operating system compatibility 

 

 

Windows 7 Windows 8.1 Windows 10 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows 7 ends in January 2020).  

Yes Yes 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 

Windows Server 2008 R2 Windows Server 2012 Windows Server 2016 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows Server 2008 R2 ends in 

January 2020) 

Yes Yes 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 
See note 1

 

VibroSight 3.4.0 or later .NET Framework 4.7.1 
See note 2

 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 
See note 3

 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers 

(rather than installing Microsoft .NET Framework 2.0). 
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